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1 INTRODUCTION 
This guide is a technical resource designed to support the Desktop Assessment 

component of the Wetland Ecosystem Service Protocol (WESP-BC). Before beginning 

this component, users should be familiar with the WESP-BC Manual and have 

completed the WESP-BC Field Assessment, including the final validation of the 

Assessment Area (AA) and Contributing Area (CA). 

 

The Desktop Assessment requires interpreting satellite imagery and provincial spatial 

datasets to answer 44 key questions. While this guide references publicly available 

province-wide datasets, users are encouraged to utilize higher-quality local data or 

superior imagery where available. Local knowledge and field notes should also be 

available while completing this assessment. 

 

All datasets mentioned are intended as reference resources; final responses should 

be based on the most suitable answer using professional judgment. Observations 

made during the field component including defined boundaries, land use 

observations, field notes, and interpretation of recent imagery must be prioritized 

over spatial datasets, which may be outdated or contain inaccuracies. 

 

This guide provides step-by-step instructions to assist users when deciding between 

multiple options. However, it is designed with the following principles in mind: 

• Proportional Effort: In many cases, not all analysis steps listed here will be 

necessary. For most sites, answers will clearly fall into the lowest or highest 

categories, and exact calculations of area or percent cover may not be 

required. 

• Oversight: The process encourages manual oversight of every question to 

mitigate issues arising from mapping inaccuracies or limited data. 

• Optimization: Users are encouraged to pursue opportunities for automation, 

provided that the integrity of the "best available data" is maintained. 

All final responses must be entered into the current WESP-BC Desktop Assessment 

Survey123 form for each site. Once the desktop questions are submitted, the .csv 

outputs from both the Field and Desktop Assessments are used within the WESPR 

tool to calculate the final function and benefit scores. 

1.1 DATA PREPERATIONS  

To make the Desktop Assessment as efficient as possible there are some analysis 

should be done first. The datasets created in these analysis should be retained and 

accompany the other data collected and packaged with WESP-BC results. To simplify 

dataset naming it is recommended to save all layers within one folder with the 

suggested standardized naming.  
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1.1.1 NECESSARY MAPPING FROM FIELD ASSESSMENT 

Prior to beginning these questions, review the data collected specifically for your site, 

and ideally have polygons delineated that were confirmed in the field for areas 

including:  

• AA that has been field verified 

This is the polygon that has been verified in the field. There are detailed instructions 

on determining the AA in the WESP-BC Manual.  

• Contributing area (watershed) 

The contributing area (watershed) is the portion of land that drains surface water into 

a common outlet (i.e., Assessment Area). It is defined by topographical features (e.g., 

ridges and hills) and flow direction, which may extend many kilometers upslope. Only 

areas that actually drain into the wetland are included and areas that flow into 

disconnected streams or basins are excluded. There are detailed instructions for 

determining the AA in the WESP-BC Manual 

• Streams observed in the field 

Any streams that were observed in the field or are visible in imagery may be useful to 

map in order to quickly determine length which will be required for some questions 

• Open water observed in the field 

Any open water areas that were observed in the field assessment or are known to 

occur should be included if they are not mapped in available datasets, as the area will 

need to be calculated for some questions 

 
Accessing provincial datasets  

Many questions in this assessment require review of provincially available datasets. 

These layers can be accessed in a variety of ways including downloading using the 

script on GitHub, or viewed online using iMap or downloaded individually from the 

BC Data Catalogue for additional information on reviewing provincially available 

datasets (Appendix A: 3). 

 
Optimizing Layer Visualization 

Prior to beginning analysis it may be advantageous to make each layer partially 

transparent in order to consider multiple layers at once. To optimize the mapping 

experience, it may be advantageous to strategically arranging the order of relevant 

layers (Appendix A: 2). 

 

2 ACQUIRING SPATIAL DATA  
To complete the analysis described in this guide, multiple publicly available datasets 

are required and summarized in Table 2.1. These datasets may not all be necessary 

for every site, or may be replaced by higher-quality locally available data, but are 
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suggested as a starting point. The package available on GitHub contains an up-to-date 

list of which of these layers can be obtained using the package. This package can be 

run by a beginner in RStudio and only requires the AA to be input as a .gpkg file. The 

package then identifies the Watershed Assessment Unit and a 10km buffer as the 

Area of Interest, for which all layers available are downloaded to a single folder. Other 

options for viewing and downloading the required spatial datasets are described in 

Appendix A.  

Table 2.1. Required Datasets for Desktop Analysis   

Dataset Name Question Relevance  

Aerial Imagery for the site and surrounding area 
*not available as part of preparing spatial data package 

All 

Land Cover Mapping  
*not currently available as part of preparing spatial data package 

OF 34, 35, 36, 37 
 

BC Wildfire Fire Perimeters – Historical (Government of British Columbia, 2025b) OF 15 

BC Cumulative Effects Framework - Human Disturbance (Government of British 
Columbia, 2023a) 

 

OF 31, 32, 41 
 

BC Cumulative Effects Framework – Integrated Roads – 2025 (Government of British 
Columbia, 2025a) 

OF 2, 9, 30, 42 

BC Historical Fish Distribution – Points (50,000) (Government of British Columbia, 
2006) 

OF 20 

Conservation Lands (Government of British Columbia, 2025c) 
OF 21, 22 

 
Critical Habitat for Federally-Listed Species at Risk - Posted (Government of British 

Columbia, 2024a) 
OF 21 

Designated Lands (GitHub File) OF 21, 22 

Digital Road Atlas (DRA) – Master Partially – Attributed Roads (Government of British 

Columbia, 2025d) 

 

OF 2 (if applicable), 
12, 30, 31, 42 

 

Ecoprovinces - Ecoregion Ecosystem Classification of British Columbia (Government 
of British Columbia, 2004) 

OF 44 

Freshwater Atlas – Lakes (Government of British Columbia, 2008b) 
OF 3, 18, 19 

 

Freshwater Atlas – Rivers (Government of British Columbia, 2025e) OF 6, 9 

Freshwater Atlas – Stream Directions (Government of British Columbia, 2023b) OF 6, 8, 9, 10, 11 

Freshwater Atlas – Glaciers (Government of British Columbia, 2008a) OF 8 

Freshwater Atlas – Stream Network (Government of British Columbia, 2024b) OF 6, 8, 9, 10, 11 

Freshwater Atlas – Watershed Groups (Government of British Columbia, 2008c) 
OF 5, 6, 9 

 

Freshwater Atlas – Watershed Boundaries (Government of British Columbia, 2025f) 
OF 11 

 

https://bcwf-wetlands.github.io/wespr/articles/prepare_spatial_data.html
https://catalogue.data.gov.bc.ca/dataset/22c7cb44-1463-48f7-8e47-88857f207702
https://catalogue.data.gov.bc.ca/dataset/7d61ff12-b85f-4aeb-ac8b-7b10e84b046c
https://catalogue.data.gov.bc.ca/dataset/a489bc6a-f676-4503-8cd7-dcf0bdf2ae99
https://catalogue.data.gov.bc.ca/dataset/3b723ef2-abd4-4722-abea-9a51258eae15
https://catalogue.data.gov.bc.ca/dataset/conservation-lands
https://catalogue.data.gov.bc.ca/dataset/critical-habitat-for-federally-listed-species-at-risk-posted-
https://github.com/bcgov/designatedlands/releases/download/v0.1.0/designatedlands.gpkg.zip
https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
https://catalogue.data.gov.bc.ca/dataset/51832f47-efdf-4956-837a-45fc2c9032dd
https://catalogue.data.gov.bc.ca/dataset/cb1e3aba-d3fe-4de1-a2d4-b8b6650fb1f6
https://catalogue.data.gov.bc.ca/dataset/f7dac054-efbf-402f-ab62-6fc4b32a619e
https://catalogue.data.gov.bc.ca/dataset/d7165359-52ef-41d0-b762-c53e3468ff3f
https://catalogue.data.gov.bc.ca/dataset/8f2aee65-9f4c-4f72-b54c-0937dbf3e6f7
https://catalogue.data.gov.bc.ca/dataset/92344413-8035-4c08-b996-65a9b3f62fca
https://catalogue.data.gov.bc.ca/dataset/51f20b1a-ab75-42de-809d-bf415a0f9c62
https://catalogue.data.gov.bc.ca/dataset/ab758580-809d-4e11-bb2c-df02ac5465c9
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2.1 GEOGRAPHIC INFORMATION SYSTEM (GIS) SOFTWARES 
The majority of office questions in this manual require the use of GIS. A variety of 

different software can be used to complete this analysis. In this guide ArcGIS Pro 3.6 

has primarily been used. Some of the foundational skills to use the software have 

been described in Error! Reference source not found.. The GIS instructions included 

in this guide assume some a basic working knowledge of GIS and utilizing tools such 

as buffers, erasing features, clipping features, calculating geometry, summarizing 

statistics, selecting intersecting features etc. Optimizing layer appearances, utilizing a 

variety of basemaps and other navigational tools may be useful to navigate the 

abundance of layers 

2.1.1 DATA PREPARATION 

To streamline the Desktop Assessment, certain preparatory steps should be done 

ahead of time to make the workflow more efficient and allow for the series of 

Freshwater Atlas – Wetlands (Government of British Columbia, 2025g) 
OF 19, 43 

 

Geology Faults  (Government of British Columbia, 2018) OF 17 

Municipalities - Legally Defined Administrative Areas of BC (Government of British 
Columbia, 2016) 

OF 1 

NGO Conservation Areas – Fee Simple (Government of British Columbia, 2024c) 
OF 22 

 

Reconnaissance Karst Potential Mapping (Government of British Columbia, 2002) 
OF 16 

 

Species and Ecosystems at Risk - Publicly Available Occurrences - CDC (Government of 
British Columbia, 2025i) 

OF 21, 22, 24 

TANTALIS – Wildlife Management Areas (Government of British Columbia, 2025k) OF 21, 22, 24 

TANTALIS – Conservancy Areas  (Government of British Columbia, 2025j) OF 21, 22 

Ungulate Winter Range – Approved (Government of British Columbia, 2025l) OF 21 

VRI – 2024 – Forest Vegetation Composite Polygons  (Government of British 
Columbia, 2024d) 

OF 28, 29, 38, 39, 40 
 

VRI –  Relational Data Dictionary (Government of British Columbia, 2019) OF 28, 29, 38, 39, 40 

Old Growth Technical Advisory Panel (TAP) – Old Forests 
*not available as part of preparing spatial data package 

OF 33 

Wildlife Species Inventory – Incidental Observations –Publicly Available (Government 
of British Columbia, 2025o) 

OF 24 

Wildlife Species Inventory – Survey Observations - Publicly Available (Government of 
British Columbia, 2025n) 

OF 24 

Wildlife Species Inventory – Telemetry Points – Publicly Available (Government of 
British Columbia, 2025p) 

OF 24 

Wildlife Habitat Features – Incidental Observations – Publicly Available  (Government 
of British Columbia, 2025m) 

OF 24 

Wildlife Habitat Features – Survey Observations – Publicly Available  (Government of 
British Columbia, 2025n) 

OF 24 

Secured Species at Risk Observations from Conservation Data Center (data request 
required) 

OF 24 

https://catalogue.data.gov.bc.ca/dataset/93b413d8-1840-4770-9629-641d74bd1cc6
https://catalogue.data.gov.bc.ca/dataset/c94e0c13-5385-49c1-9922-822e10135fc6
https://catalogue.data.gov.bc.ca/dataset/e3c3c580-996a-4668-8bc5-6aa7c7dc4932
https://catalogue.data.gov.bc.ca/dataset/a306e21b-58d6-4b71-bac7-f3b1c8a4c779
https://catalogue.data.gov.bc.ca/dataset/395568e1-d233-4217-9732-7afadb6f4265
https://catalogue.data.gov.bc.ca/dataset/species-and-ecosystems-at-risk-publicly-available-occurrences-cdc
https://catalogue.data.gov.bc.ca/dataset/tantalis-wildlife-management-areas
https://catalogue.data.gov.bc.ca/dataset/550b3133-2004-468f-ba1f-b95d0e281e78
https://catalogue.data.gov.bc.ca/dataset/ungulate-winter-range-approved
https://catalogue.data.gov.bc.ca/dataset/6ba30649-14cd-44ad-a11f-794feed39f40
https://www2.gov.bc.ca/assets/gov/farming-natural-resources-and-industry/forestry/stewardship/forest-analysis-inventory/data-management/standards/vegcomp_poly_rank1_data_dictionaryv5_2019.pdf
https://catalogue.data.gov.bc.ca/dataset/6f08c9d8-d6c0-4f08-ac64-54585c92ccb0
https://catalogue.data.gov.bc.ca/dataset/7d5a14c4-3b6e-4c15-980b-68ee68796dbe
https://catalogue.data.gov.bc.ca/dataset/8f45a611-ce07-4e9f-a4b5-27e123972816
https://catalogue.data.gov.bc.ca/dataset/6d48657f-ab33-43c5-ad40-09bd56140845
https://catalogue.data.gov.bc.ca/dataset/50dc6ba5-8883-4bfc-b3aa-b420b190b45b
https://catalogue.data.gov.bc.ca/dataset/884c20fa-17c1-491a-b5cb-993be5dff8d3
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questions to be completed quickly. It is suggested to follow naming conventions 

described in Table 4.1, to ensure that the relevant layer can be found when following 

steps in this document. Some datasets are described as being optional, such as lakes 

clipped to 2km would not be necessary if there are no lakes within the 2km buffer. 

These datasets are optional as they may not apply to all situations. Generally, if any 

of the datasets in  Table 4.1 are necessary to answer the question for the site of 

interest, then they should accompany the site data in a geodatabase. 

 

 

Table 2.2 Necessary Dataset Analysis for Desktop Assessment   

Dataset Name Description Relevant Question 

“AA” 

Delineated Wetland or Assessment Area 
(AA), based on AA guidance in the WESP-BC 

Manual  
Attributes including area in Hectares (Ha) 

All questions 

“AA_OpenWater” Open water observed in the field  

“Streams_field_verified” 
Streams mapped based on recent imagery or 

field observations 
 

“Buffer_2km_excluding_AA” 
2km buffer around the AA with the AA 

polygon excluded 
OF 31, 32, 33 

“Buffer_100m_excluding_AA” 
100m buffer around the AA with excluding 

the wetland 
OF 30 

“Buffer_100m_including_AA” 100m buffer including the AA  OF 21,OF 36 

“Buffer_1km” 1km buffer polygon around the AA OF 34 

“Buffer_2km” 2km buffer polygon around the AA OF 18, 19, 37 

“Buffer_5km” 5km buffer polygon around the AA OF 34 

“Buffer_10km” 10km buffer polygon around the AA OF 4 

“Lakes_clipped_2km” 
 

All mapped lakes clipped to a 2km buffer 
Hectares field calculated 

 
OF 18, 19 

“Wetlands_clipped_2km ” 
Portions of mapped wetlands inside the 2 

km buffer of the AA 
Hectares field calculated 

OF 19 

“Wetland_100m_Buffer” Wetlands within 100m buffer OF 12 

“CA_polygon” 
Manually digitized polygon representing the 

full contributing area 
OF 11 

“CA_excluding_AA” 
Contributing area polygon where AA is 

removed 
OF 11 

“Disturbed_WAU” Disturbance within the WAU boundary OF 41 

“WAU” 
Watershed Assessment Unit (WAU) that 

wetland falls within 
OF 12, 41, 42, 43 

“Forests_within2km” Forests within 2km buffer OF 33 
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Contributing Area Excluding The AA  

1. Modify the Contributing Area (CA) polygon that wasmappe verified in the field: 

i. Go to Edit > Create Features > Polygon template. 

ii. Trace the CA boundary starting from the wetland outlet, following 

contours, terrain, contours, and stream flow direction. 

iii. Save the polygon (e.g., CA_polygon). 

2. Erase the AA from the CA polygon: 

i. see 11 
ii. Save CA without AA as “CA_excluding_AA”. 

3.   Calculate AA area: 
i. Open the Attribute Table for both AA_polygon and CA_excluding_AA. 

ii. Confirm the Shape_Area field (units: m2). 
iii. If necessary, add a new field (e.g., Area_ha) and calculate hectare by 

dividing the Shape_Area by 10,000. 
 

2.2 BUFFERS 
Buffers for AA should be created for multiple distances: 

a. < 100 m “Buffer_100m” 

b. 100 - 500 m “Buffer_500m” 

c. 0.5 - 1 km “Buffer_1km” 

d. 1 - 5 km “Buffer_5km 

e. > 5 km “Buffer_larger_than_5km” 

f. 10 km “Buffer_10km” 

NOTE: Refer to Appendix-A for buffer tool instructions. 

Buffers may be useful to determine presence or absence of specific features within a certain 

distance. In some cases, buffers may also useful to clip other datasets in order to calculate areas 

or determine percentage coverage.  

 
Buffer 2km Excluding AA 

“AA_Landcover” Land cover features clipped to the AA OF 35 

“Landcover_1km” Land cover within 1km buffer OF 34 

“Landcover_5km” Land cover within 1km buffer OF 34 

“Landcover_AA_100m” Landcover within 100m including AA OF 36 

“Mature_OldGrowth_within2km” 

 
Mature or old growth forests within 2km 

buffer 
OF 33 

“Roads_WAU” Roads with the WAU boundary Of 42 

“HumanDisturbance_2km” 
Human disturbance layer clipped to within 

2km 
OF 32 

“AllRoads_100m” All roads within 100m buffer of the AA OF 30 

“AA_DesignatedOverlap” 
Portion of the AA intersecting designated 

conservation/ecological lands 
OF 21 
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Modify the 2km buffer and remove the AA 

1. Select and export “Buffer_2km” layer.  

2. Remove the AA from the buffer (see 11) and save it as 

“2km_buffer_excluding_AA”. 
Buffer 100m Including AA 

1. Create a 100 m buffer around the AA (save as “Buffer_100m”). 

2. Merge AA and buffer into a single extent: 

i. Use the Union (Analysis) or Merge (Data Management) tool. 

ii. Input Features = AA_polygon and Buffer_100m. 

iii. Save as “Buffer_100m_including_AA”. 

 
Buffer 100m Excluding AA  

1. Select and export “Buffer_100m” layer. 

2. Remove the wetland from the buffer using the Erase tool (see 11). 

i. Save as “Buffer_100_NoWetland” 

3. Select intersecting roads by adding the DRA – Master Partially – Attributed 

Roads layer. 

4. Use Buffer_100_NoWetland to select intersecting roads. 

 
Lakes Within 2km 

The steps to create this layer can be replicated to create other layers that may apply 

only within specific buffers. 

1. Modify the lakes layer if there are other lakes not mapped but are known to exist 
based on local knowledge, other datasets, or imagery interpretation 

2. Clip lakes to the 2 km buffer (Analysis > Clip): Go to Analysis tab > Tools > search 
for Clip. 

ii. Input Features = Lakes (Freshwater Atlas). 
iii. Clip Features = “Buffer_2km”. 

i. Output Feature Class = “Lakes_clipped_2km”. 
Calculate lake areas using Calculate Geometry (Appendix A): 

i. Save as “Lakes_clipped_2km”. 
  

https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
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3 DESKTOP ASSESSMENT SURVEY 

3.1 HOW TO INTERPRET QUESTION GUIDANCE 

Each Desktop Assessment question described below includes recommended datasets, 

analysis process, and in some cases additional guidance to consider when answering each 

question. The description for each question may not include every component, but 

generally follows a similar structure: 

 

OF# THE QUESTION TITLE THAT CORRESPONDS TO THE SURVEY123 QUESTION AND OTHER WESP 

RESOURCES  

Relevant Layers 
o Links to layers that may be beneficial to consider  
o Aerial Imagery – may also be listed if key to consider 

 

“Exact question as described on the Survey123 form” 

 

NOTE: additional hints or helpful information may be included in a note. This is 

typically also included in the Survey123 form. 

 

Question options including specification of answer format (select one, select multiple, 

integer, decimal etc.):  

o Options or text data 

o Formatted to match Survey123 form options 

 

1. Specific steps to complete analysis will be included,  
a. These steps may include links to specific appendix resources. 

2.  If the answer is obvious from reviewing datasets and imagery these steps may 
not be required to complete for all sites 

 

3.1.1 OF 1: DISTANCE TO COMMUNITY  

Relevant Layers:  

o Assessment Area (AA) 

o Aerial Imagery 

o Municipalities - Legally Defined Administrative Areas of BC 

 

“The distance from the AA's edge to the nearest settlement (>5 residences per 

square km) or legally recognized municipality or community is:” 

 

NOTES: 

https://catalogue.data.gov.bc.ca/dataset/e3c3c580-996a-4668-8bc5-6aa7c7dc4932
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• Settlements can include clusters of homes, small communities, municipalities, 

or reserves. Use your judgment based on visible infrastructure and settlement 

patterns. 

• Use the most recent imagery to visually inspect the area. Apply buffers or the 

measure tool to determine the distance to the nearest residential area. 

 

Select one of the following: 

o < 100 m 

o 101 - 500 m 

o 500 m - 1 km 

o 1.01 - 5 km 

o > 5.01 km 

 

3.1.2 OF 2: DISTANCE TO FREQUENTLY TRAVELLED ROAD 

Relevant Layers 

o BC Cumulative Effects Framework – Integrated Roads – 2025 

o Digital Road Atlas (DRA) – Master Partially – Attributed Roads 
o Aerial Imagery 

 

“The distance from the AA center to the nearest road with an average daytime 

traffic rate of > 1 vehicle/ minute is:” 

 

NOTE: Only consider paved roads, confirm with aerial imagery or the Digital Road 

Atlas for road classification. DO NOT include trails, ATV routes, or unmaintained roads. 

 

Select one of the following: 

o < 10 m 

o 11 - 25 m 

o 26 - 50 m 

o 51 - 100 m 

o 101 - 500 m 

o > 501 m 

 

3. Add the relevant layers. 
4. Adjust the symbology for clarity. 
5. Measure the distance from the center of the AA to the nearest main paved 

road, or use the buffers to visually determine distance to the nearest road. 
3.1.3 OF 3: DISTANCE TO PONDED WATER 

Relevant Layers: 

o Aerial Imagery 

o Freshwater Atlas – Lakes 

https://catalogue.data.gov.bc.ca/dataset/a489bc6a-f676-4503-8cd7-dcf0bdf2ae99
https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
https://catalogue.data.gov.bc.ca/dataset/cb1e3aba-d3fe-4de1-a2d4-b8b6650fb1f6


W E S P - B C  D E S K TO P  A S S E S S M E N T  1 4   |   B . C .  W I L D L I F E  F E D E R AT I O N   

14 

 

“The distance from the AA edge to the closest (but separate) body of fresh water 

(wetland, pond, or lake) that is ponded all or most of the year:” 

NOTES:  

• This method is for determining the distance from the AA to the nearest 

ponded freshwater feature (not rivers/streams). 

• Focus on separate ponded features that do not appear to be part of the 

same continuous wetland. 

• "Abutting" means directly touching without a 100+ m upland or 

infrastructure gap. 

• You may count ponded areas obscured by vegetation if imagery, seasonal 

differences, or persistent saturation indicators suggest they are present. 

 

Select one of the following: 

o <100 m, and not separated by any width of paved roads, bare ground, or 

impervious surface. 

o <100 m, but completely separated by those features. 

o 101 m-1 km, and not separated. 

o 101 m-1 km, but separated by those features. 

o 1.05-5 km, and not separated. 

o 1.05-5 km, but separated by those features. 

o None of the above (the closest patches or corridors that are large, are more 

than 5 km away).  

 

1. Add the Freshwater Atlas – Lakes layer. 

2. Identify the AA and use the imagery basemap to visually locate nearby ponded 

water. 

3. Measure from the edge of the AA to the nearest ponded feature: 

i. If separated by roads, bare ground, or impervious surfaces wider than 100 

m, treat that body of water as being separate from the AA. 

3.1.4 OF 4: DISTANCE TO LAKES 

Relevant Layers: 

o Aerial Imagery 

o Freshwater Atlas – Lakes 

 

“The distance from the AA edge to the closest (but separate) ponded water body 

larger than 8 hectares during most of a normal year is:” 

NOTES:  

• Ensure the lake is within the 10 km buffer (lakes smaller than 8 ha should be 

excluded). 

https://catalogue.data.gov.bc.ca/dataset/cb1e3aba-d3fe-4de1-a2d4-b8b6650fb1f6
https://catalogue.data.gov.bc.ca/dataset/cb1e3aba-d3fe-4de1-a2d4-b8b6650fb1f6
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• For islands, use only the island containing the AA, not all islands included in 

the watershed polygon. 

• DO NOT use rivers/flowing water to define watershed boundaries; always use 

mapped watershed polygons. 

 

Select one of the following: 

o <100 m 

o 101 m-1 km 

o 1.01-5 km 

o 5.01-10 km 

o >10.01 km 

 

1. Consider “Buffer_10km”. 

2. Identify the AA and use the imagery basemap to visually locate the largest 

(larger than 8 ha) nearby ponded water. 

3. Measure from the edge of your AA to the largest nearby ponded water. 

3.1.5 OF 5: RELATIVE ELEVATIONS IN WATERSHED 

Relevant Layers: 

o Elevation data (Topographic map sufficient) 

o Freshwater Atlas – Watershed Groups 

1. If field GPS elevations are not available, add a Topographic basemap (see 
Error! Reference source not found.) 

2. Identify the AA polygon: 
i. Use the Explore Tool (default cursor) or Identify Tool, click near the 

center of the polygon, and record the elevation (meters). 
3. Add the Freshwater Atlas – Watershed Groups layer. 

i. Use the Identify Tool, click inside the AA polygon and record the 
watershed group name. 

ii. Examine available elevation data for the watershed group and 
determine the highest and lowest elevation for the watershed group. 
For South Coast Region:  

1. Lower Fraser is 2200m range 
2. Harrison River is 2250 m range 
3. Chilliwack River is 2400m range 

4. Calculate relative elevation using the formula below: 

𝑹𝒆𝒍𝒂𝒕𝒊𝒗𝒆 𝑬𝒍𝒆𝒗𝒂𝒕𝒊𝒐𝒏 =
𝑨𝑨 𝑬𝒍𝒆𝒗𝒂𝒕𝒊𝒐𝒏 − 𝑴𝒊𝒏𝒊𝒎𝒖𝒎 𝑬𝒍𝒆𝒗𝒂𝒕𝒊𝒐𝒏

𝑬𝒍𝒆𝒗𝒂𝒕𝒊𝒐𝒏 𝑹𝒂𝒏𝒈𝒆 𝒐𝒇 𝑾𝒂𝒕𝒆𝒓𝒔𝒉𝒆𝒅
  

• This calculation expresses the AA’s elevation relative to its watershed: whether 

it lies near the bottom, middle, or top of the watershed. 

 

https://catalogue.data.gov.bc.ca/dataset/51f20b1a-ab75-42de-809d-bf415a0f9c62
https://catalogue.data.gov.bc.ca/dataset/freshwater-atlas-watershed-groups
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3.1.6 OF 6: STREAM INTERSECT 

Relevant Layers: 

o Aerial Imagery 
o Freshwater Atlas – Watershed Groups 
o Freshwater Atlas – Stream Directions – Points 
o Freshwater Atlas – Stream Network – Lines, Edge Type 
o Freshwater Atlas – Rivers 

“Do topographic maps or the Freshwater Atlas show a stream flowing out of the 

AA's wetland and into a downslope stream network, or does the AA abut a river 

and is probably flooded by the river periodically?” 

NOTES:  

• In the Freshwater Atlas – Stream Network, the following line types should be 

ignored unless field observations indicate otherwise: 

i. Flow Connector 

ii. Isolated Waterbody Skeleton 

iii. Underground Connector 

iv. Inferred Connector 

 

Select one of the following: 
o Yes 

o No 

 

1. Add the relevant layers. 
2. To symbolize streams: 

i. In the Contents pane, right-click the layer (e.g., Stream Network) > 
Symbology > set Primary Symbology = Unique Values. 

ii. In the Field drop-down, select EDGE_TYPE. 
iii. Add All Values except for the above specified line types. 

3. Visually inspect whether the AA polygon intersects with valid streams or 
rivers. 

i. Use aerial imagery and stream direction points to confirm flow 
direction. 

4. Interpret results: 
i. If a clear stream flows out of the AA and connects to the downslope 

network → Yes. 
ii. If the AA abuts a river that can flood it periodically → Yes. 

iii. Otherwise → No. 
3.1.7 OF 7: ASPECT 

Relevant Layers: 

o Elevation or slope/aspect raster (e.g., RESULTS Openings Slope Aspect and 

Elevation) 

o Topographic contours (e.g., TRIM Contour Lines) 

https://catalogue.data.gov.bc.ca/dataset/51f20b1a-ab75-42de-809d-bf415a0f9c62
https://catalogue.data.gov.bc.ca/dataset/d7165359-52ef-41d0-b762-c53e3468ff3f
https://catalogue.data.gov.bc.ca/dataset/92344413-8035-4c08-b996-65a9b3f62fca
https://catalogue.data.gov.bc.ca/dataset/f7dac054-efbf-402f-ab62-6fc4b32a619e
https://catalogue.data.gov.bc.ca/dataset/92344413-8035-4c08-b996-65a9b3f62fca
https://catalogue.data.gov.bc.ca/dataset/57b8ba13-cd01-43a5-9910-bc18375426d0
https://catalogue.data.gov.bc.ca/dataset/57b8ba13-cd01-43a5-9910-bc18375426d0
https://catalogue.data.gov.bc.ca/dataset/8edde26d-aea0-47e9-bab1-e7c6226181ae
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“The overland flow direction of most surface water (in streams, rivers, or runoff) 

that enters the AA is: N, NE, S, SE, E SE, W, NW, or flat” 

NOTE: If flow direction is unclear or diffuse, consider the mean aspect of the 

surrounding watershed. 

Select one of the following: 

o Northward (N, NE), north-facing contributing area 

o Southward (S, SW), south-facing contributing area 

o Other (E, SE, W, NW), or no detectable uphill slope or input channel (flat) 

 

1. Add the AA polygon and an elevation or slope/aspect raster. 
i. For easier interpretation, add a Hillshade or Aspect raster (e.g., BC 

DEM Hillshade). 
ii. Alternatively, use the Topographic basemap (see Error! Reference 

source not found.). 
2. Assess the surrounding terrain: 

i. Identify the dominant slope direction draining into the AA. 
ii. Look for elevation patterns, flow channels, or upslope contributing 

areas. 
iii. Use contour lines to confirm slope gradients in upland areas. 

3. Determine dominant flow direction entering the AA: 
i. Consider slope, stream direction, and landform orientation. 

ii. If no clear slope or channel exists, treat the AA as “Flat”. 
4. Select the best category: 

i. If flow originates from a north-facing slope (flowing south), choose 
Southward (S, SW). 

ii. If flow originates from a south-facing slope (flowing north), choose 
Northward (N, NE). 

iii. If flow comes mainly from E, SE, W, NW, or terrain is flat, choose 
Other. 
 

3.1.8 OF 8: GLACIER INFLUENCE 

Relevant Layers:  

o Freshwater Atlas – Stream Directions  

o Freshwater Atlas – Stream Network 

o Freshwater Atlas – Glaciers 

o Glaciers 

“Select first true choice” 

o No glacier capable of contributing surface flow to the AA is present upstream. If 

a glacier is present, there is no surface connection to the AA. 

https://catalogue.data.gov.bc.ca/dataset/d7165359-52ef-41d0-b762-c53e3468ff3f
https://catalogue.data.gov.bc.ca/dataset/92344413-8035-4c08-b996-65a9b3f62fca
https://catalogue.data.gov.bc.ca/dataset/8f2aee65-9f4c-4f72-b54c-0937dbf3e6f7
https://catalogue.data.gov.bc.ca/dataset/832b4523-7853-4ec5-8f9c-4314a0154927
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o Glacier connected by streams to the AA is present upstream, but clarity or 

temperature of the AA's surface water is seldom or never affected (because it is 

too distant from glacier). 

o Glacier connected by streams to the AA is present upstream and the clarity or 

temperature of the AA's surface water is regularly affected.  

NOTE: Consider whether the AA is in a glacial-headed watershed (high influence) or 

is located downstream of a glacial-headed watershed (low influence). 

 

1. Add the relevant layers. 

2. To check upstream of the AA, zoom to the AA polygon and pan upstream 
within the watershed. 

i. Identify any mapped glaciers in the watershed. 
ii. Use the stream network and stream direction points to confirm if a 

surface water connection exists between the glacier and the AA. 
3. Interpret results: 

i. If no glacier is upstream or no surface connection exists, select 
Option 1. 

ii. If a glacier is connected by streams but is too distant to affect water 
clarity or temperature, select Option 2. 

iii. If a glacier is connected by streams and regularly influences AA water 
clarity/temperature, select Option 3. 

3.1.9  OF 9: FLOODABLE INFRASTRUCTURE 

Relevant Layers: 

o Aerial Imagery 

o Freshwater Atlas – Rivers 

o Freshwater Atlas – Stream Network 

o Freshwater Atlas – Stream Directions 

o BC Cumulative Effects Framework – Integrated Roads – 2025 

o Freshwater Atlas – Watershed Groups 

 

“Is there infrastructure that is at risk of flooding within 5 km of the wetland?” 

NOTES: 

• Do NOT include agricultural fields, gravel pits, or other mined lands unless 

clearly built-up with public infrastructure. 

• Infrastructure is considered “vulnerable” if: 

o It has experienced flood damage in the past 100 years without 

protection, 

o It lies within a mapped 100-year floodplain, or  

o It is in an alluvial floodplain and less than 3 m above the expected 

annual high water (e.g., bankfull stage). 

https://catalogue.data.gov.bc.ca/dataset/f7dac054-efbf-402f-ab62-6fc4b32a619e
https://catalogue.data.gov.bc.ca/dataset/92344413-8035-4c08-b996-65a9b3f62fca
https://catalogue.data.gov.bc.ca/dataset/d7165359-52ef-41d0-b762-c53e3468ff3f
https://catalogue.data.gov.bc.ca/dataset/a489bc6a-f676-4503-8cd7-dcf0bdf2ae99
https://catalogue.data.gov.bc.ca/dataset/51f20b1a-ab75-42de-809d-bf415a0f9c62
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• Define “floodable infrastructure” as features lying downstream or downslope 

within the same watershed. Consider whether upstream wetlands contribute 

to flood risk; if none are relevant, record as “none.”. 

• The “watershed” refers to the “Freshwater Atlas Watershed Groups”. 

• Consider temporary damming effects from ice jams that could occur 

downstream in the vicinity of the AA. 

 

“Select first true choice” 

o Within 1 km: Infrastructure vulnerable to river flooding is present downstream or 

downslope within 1 km of the AA and in the same watershed. 

o Within 5 km: Infrastructure vulnerable to river flooding is present downstream or 

downslope within 5 km of the AA in the same watershed.  

o >5 km: Infrastructure vulnerable to river flooding is present downstream or 

downslope at a farther distance but within the same watershed.  

o None: No infrastructure vulnerable to river flooding is present downstream or 

downslope in the AA's watershed. 

1. Consider “Buffer_5km” (Appendix-A). 

2. Use the Measure Tool to identify infrastructure within the buffer that is: 

i. Close to stream channels or rivers flowing downstream or out of the 

AA. 

ii. Located on the floodplain or visibly near channels within low-lying 
areas. 

3. Look for indicators of potentially flood-vulnerable infrastructure, including: 

• Buildings 

• Bridges 

• Actively used roads 

• Pipelines 
3.1.10 OF 10: INTERNAL FLOW DISTANCE 

Relevant Layers: 

o Aerial Imagery 

o Freshwater Atlas – Stream Directions   

o Freshwater Atlas – Stream Network 

 

“How long is the stream that is intersecting the wetland?”   

NOTES: 

• This measurement represents the internal flow path through the AA. 

• A valid flow path requires both an inlet and outlet (natural or mapped). 

• Where a mapped stream intersects the AA, measure only the channel length 

within the AA boundary. 

• Exclude short tributaries or inflows that do not continue through the wetland. 

https://catalogue.data.gov.bc.ca/dataset/51f20b1a-ab75-42de-809d-bf415a0f9c62
https://catalogue.data.gov.bc.ca/dataset/d7165359-52ef-41d0-b762-c53e3468ff3f
https://catalogue.data.gov.bc.ca/dataset/92344413-8035-4c08-b996-65a9b3f62fca
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Select one of the following:  

o < 10 m 

o 11-50 m 

o 51-100m 

o 101m-1 km 

o 1.01-2km 

o > 2.01 km, or the wetland lacks an inlet and/or outlet 

 

Identify inlets and outlets, if any, from topographic maps (use elevations to determine 

which are inlets and which are outlets) and augment with field inspection. Estimate 

distance along the length of the largest stream channel passing from inlet to outlet. 

If no channel is visible, estimate the straight-line distance between the highest and 

lowest point within the AA. 

 

1. Add the relevant layers:  

i. Add the stream network layer prepared in OF 6 (with invalid 

EDGE_TYPE values removed).  

ii. Add aerial imagery for visual confirmation.  

2. Identify inlets and outlets by using stream directions and elevation/contours 

to determine inflow vs. outflow points.  

3. Open the Measure Tool (see 8) to trace the channel path from inlet to outlet 

within the AA boundary, clicking along bends to capture curvature. 

i.  If mapped streams differ from visible/field-observed channels, use the 

observed channel. 

4. If multiple streams exist, measure each candidate segment, and record the 

longest measure length as the internal flow distance. 

5. If no mapped stream is present, use elevation data/contour lines to estimate 

the straight-line distance between the highest and lowest points within the AA. 

6. Record the results length in meters and select the correct category. 

3.1.11  OF 11: WETLAND AS A % OF ITS CONTRIBUTING AREA (CATCHMENT)  

Relevant Layers:  

o Aerial Imagery 

o Freshwater Atlas – Stream Directions  

o Freshwater Atlas – Stream Network 

o Freshwater Atlas – Watershed Boundaries 

“What percentage of the catchment area does the wetland take up?”  

 

NOTES: 

• Identifying the contributing area (CA) of the AA’s wetland is the part of the 

watershed that potentially drains toward and feeds into the AA, which may 

https://catalogue.data.gov.bc.ca/dataset/d7165359-52ef-41d0-b762-c53e3468ff3f
https://catalogue.data.gov.bc.ca/dataset/92344413-8035-4c08-b996-65a9b3f62fca
https://catalogue.data.gov.bc.ca/dataset/ab758580-809d-4e11-bb2c-df02ac5465c9
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extend upslope for many kilometers. Exclude any areas that flow into streams 

not connected to the AA. 

• If needed, use aerial imagery, stream data, and field observations to refine the 

CA boundary. Then, calculate the wetland’s % of its CA by dividing the wetland 

area (excluding the AA itself) by the CA (minus the wetland). 

• The CA should reflect the actual hydrological inputs to the wetland. Adjust the 

default watershed polygon using topographic or stream data if needed. 

• When calculating area, include ponded water that abuts the wetland as part 

of the wetland area. 

• In flat headwater areas or isolated basins, the wetland may be larger than its 

effective catchment. 

 

Select one of the following: 
o <1%, or contributing area is unknown due to stormwater pipes that collect water 

from an indeterminate area 
o 1.1-10% 
o 10.1-100% 
o >100.1% (wetland is larger than its contributing area (e.g., headwater wetland 

with flat surrounding terrain and no inlet, or entirely isolated by dikes, or a raised 
bog). Skip to OF 13. 
 
1. Delineate and prepare the Contributing Area (CA) (see Data Prep, Section .) 

i. Trace and save the CA_polygon. 
ii. Erase the AA from the CA (see 11). 

iii. Save as “CA_excluding_AA”. 
2. Check and calculate areas: 

i. Confirm area fields for both AA_polygon and CA_excluding_AA (m² or 
hectares). 

i. If needed, calculate hectares (Shape_Area ÷ 10,000).  
3. Calculate wetland % of CA: 

i. Use formula below: 

𝑊𝑒𝑡𝑙𝑎𝑛𝑑 % 𝑜𝑓 𝐶𝐴 =
𝐴𝐴 𝐴𝑟𝑒𝑎

𝐶𝐴_𝑒𝑥𝑐𝑙𝑢𝑑𝑖𝑛𝑔_𝐴𝐴
 

 
ii. Record results as a percentage and select the appropriate category. 

3.1.12  OF 12: UNVEGETATED SURFACE IN THE WETLAND’S WAU: 

o Aerial Imagery 

o Digital Road Atlas (DRA) – Master Partially – Attributed Roads 

 

“The proportion of the WAU comprised of buildings, roads, parking lots, other 

pavement, or bare soil at the time of peak annual runoff is about:” 

https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
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NOTE: Calculate the total area of unvegetated or impervious surfaces (e.g., buildings, 

pavement, bare ground) within the Watershed Assessment Unit (WAU) (100 m 

buffer), then estimate the proportion this represents of the buffer area. 

Select one of the following:  

o <10% 

o 10.1-25% 

o >25.1% 

 

1. Consider the layer “Wetland_100m_Buffer”. 
i. Symbolize with transparent fill and a visible outline (see 2).  

2. Scan the buffer for unvegetated/impervious surfaces by using aerial 
imagery. 

i. Look for paved roads, parking lots, rooftops, bare soil, gravel, or rocky 
outcrops. 

ii. Exclude temporary features (e.g., cutblocks). 
3. Use the Digital Road Atlas (DRA) layer to confirm paved and developed road 

segments. 
4. Visually estimate % of buffer covered by impervious/unvegetated surfaces 

while considering the options.  
i. If difficult to judge visually, use the Measure tool or digitized 

polygons around built-up areas to calculate. 
5. Record and select the appropriate category. 

3.1.13 OF 13: CONSERVATION INVESTMENT  

o No layers required. This question relies on local information and research on 

of the site. 

“The AA is within or abuts a wetland on which public or private organizational funds 

were spent to preserve, create, restore, or enhance the wetland. If unsure, ask the 

property owner.”  

 

NOTES: 

• No mapping analysis is required for this question. 

• If not already known, contact the landowner or local authority to determine 

whether conservation, restoration, or enhancement funds were invested in 

the wetland. 

Select one of the following:  

o Yes 

o No 

3.1.14 OF 14: SUSTAINED SCIENTIFIC USE 

o No layers required. This question relies on local information. 

“Has there been sustained scientific use of the wetland?” 

NOTES:  

https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
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• No GIS mapping is required for this question. 

• Consider whether the AA has been monitored for more than 2 years (plants, 

animals, or water), with data available to the public and not tied to 

regulatory requirements. Also, check if the AA is part of a designated 

benchmark, reference, or status-trends monitoring area. If the wetland is 

within a park or conservation area, do a quick search to confirm whether 

monitoring or research has been conducted. 

Select one of the following:  

o Yes 

o No 

 

3.1.15 OF 15: BURNED 

Relevant layers:  

o BC Wildfire Fire Perimeters – Historical 

 

Has any part of the Assessment Area (AA) burned since 2010? 

NOTE: The 100 m distance accounts for fire effects that may extend slightly beyond 

the mapped perimeter. 

 Select one of the following:  

o Yes 

o No 

 

1. Add the layer and ensure the AA polygon is visible. 

2. Visually inspect whether a fire perimeter overlaps the AA or extends within 

100 m of the boundary.  

i. If needed, check the burn year attribute to confirm whether the fire 

occurred within the last 25 years. 

3.1.16 OF 16: KARST GEOLOGY 

Relevant Layer:  

o Karst Potential  

 

“The AA's wetland is within a geologic unit having a significant karst (limestone, 

calcium carbonate) component.”  

• Visual confirmation from local experts or detailed geological mapping is 

recommended where karst presence is suspected. 

• "Other information" may include advice of qualified geologists or other maps 

of local geology.  

 

Select one of the following:  

o Yes 

https://catalogue.data.gov.bc.ca/dataset/22c7cb44-1463-48f7-8e47-88857f207702
https://catalogue.data.gov.bc.ca/dataset/395568e1-d233-4217-9732-7afadb6f4265
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o No 

 

1. Add the Karst Potential layer. 

2. Arrange layers so the karst layer is displayed above the AA polygon. 

3. Check if the AA overlaps areas classified as High (H) or Medium (M) karst 

intensity.  

4. If no karst layer is available: 

i. Use regional geology layers or maps showing limestone-rich 

Paleozoic/Mesozoic formations. 

3.1.17 OF 17: GEOLOGIC FAULTS 

Relevant Layer: 

o Geology Faults 

 

“The AA's wetland abuts or is intersected by a geologic fault.” 

Select one of the following:  

o Yes 

o No 

 

1. Add the Geology Faults layer. 

2. Overlay with the AA:  

i. Ensure both the wetland (AA) and the fault line layer are visible. 

ii. Arrange layers so the fault line layer is displayed above the AA 

polygon. 

iii. Visually inspect whether any fault lines cross or touch the AA 

boundary 

3. If difficult to determine by visual inspection (such as on very large sites) then 

consider using the intersect tool (Appendix A: 9). 

3.1.18 OF 18: LAKES WITHIN 2 KM 

Relevant Layers: 

o Aerial Imagery 

o Freshwater Atlas – Lakes 

 

“Considering Freshwater Atlas-Lakes, consider the 2km buffer. Based on visual 

estimation or measurement, the percentage of that circle occupied by lakes is:” 

NOTES 

• Focus only on permanent open-water lakes.  

• Exclude wetlands, ephemeral ponds, and seasonal water bodies unless clearly 

mapped as lakes for this question (these other areas are considered in OF 19). 

 

https://catalogue.data.gov.bc.ca/dataset/395568e1-d233-4217-9732-7afadb6f4265
https://catalogue.data.gov.bc.ca/dataset/c94e0c13-5385-49c1-9922-822e10135fc6
https://catalogue.data.gov.bc.ca/dataset/c94e0c13-5385-49c1-9922-822e10135fc6
https://catalogue.data.gov.bc.ca/dataset/cb1e3aba-d3fe-4de1-a2d4-b8b6650fb1f6
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Select one of the following:  

o <2% 

o 2.1-7% 

o 8-17% 

o 18-34% 

o >34.1% 

1. Consider the Lakes layer  
2. Calculate the total buffer area: 

i. In the Attribute Table of Buffer_2km, add a field (e.g., Buffer_Ha). 
ii. Use Calculate Geometry to populate the buffer area in hectares (see 

10). 
3. Calculate the total buffer area using the formula below: 

𝐿𝑎𝑘𝑒 % 𝑜𝑓 𝐵𝑢𝑓𝑓𝑒𝑟 =  
𝑇𝑜𝑡𝑎𝑙 𝐿𝑎𝑘𝑒 𝐴𝑟𝑒𝑎

𝑇𝑜𝑡𝑎𝑙 𝐵𝑢𝑓𝑓𝑒𝑟 𝐴𝑟𝑒𝑎 
 𝑋 100 

3.1.19 OF 19: WETLANDS AND LAKES WITHIN 2 KM 

Relevant Layers: 

o Freshwater Atlas – Lakes 

o Freshwater Atlas – Wetlands 

 

“Also load this layer: Base Maps> Freshwater Atlas> Wetlands. Based on visual 

estimation, the percentage of that circle occupied by wetlands AND lakes combined 

is:” 

NOTES: 

• You can union the lakes and wetlands layers before measuring, then calculate 

the combined area in a single step. 

• Consider permanent open water as well as mapped wetland areas within the 

buffer. 

• This value should be larger than the value of OF 18 which only considered 

lakes within 2km. 

 

Select one of the following:  

o <2% 

o 2.1-7%  

o 8-17%  

o 18-34% 

o >34.1% 

 

1. Consider the dataset created in OF 18. 

i. Visually inspect if there are any lakes or wetlands within the 2km buffer. 

ii. If it is difficult to determine the precise area coverage of these features, 

then follow steps 2-5 to determine the areas.  

https://catalogue.data.gov.bc.ca/dataset/cb1e3aba-d3fe-4de1-a2d4-b8b6650fb1f6
https://catalogue.data.gov.bc.ca/dataset/93b413d8-1840-4770-9629-641d74bd1cc6
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2. Clip wetland layers to buffer boundary (see 12) 

i. ii. Save as “Wetlands_clipped_2km”.  

3. Calculate total areas using Calculate Geometry (see 10). 

4. Use the formula below to answer the question:𝑊𝑒𝑡𝑙𝑎𝑛𝑑 +

𝐿𝑎𝑘𝑒 % 𝑜𝑓 𝐵𝑢𝑓𝑓𝑒𝑟 =  
𝐿𝑎𝑘𝑒 𝐴𝑟𝑒𝑎+𝑊𝑒𝑡𝑙𝑎𝑛𝑑 𝐴𝑟𝑒𝑎

𝐵𝑢𝑓𝑓𝑒𝑟 𝐴𝑟𝑒𝑎
 𝑋 100 

3.1.20 OF 20: FISH OCCURRENCE 

Relevant Layers: 

o BC Historical Fish Distribution – Points (50,000) 

The following iMapBC layer is required: 

o Fish Wildlife and Plant Species > All Fish Points 

 

“Score all the conditions below that are true based on your own observations, 

information from agency biologists, or this iMapBC layer:  Fish Wildlife and Plant 

Species> All Fish Points (use the Identify tool and click on the points to see the 

species reported).” 

 

NOTES:  

• Watershed connectivity and proximity determine the appropriate score 

option (within AA, within 8 km, or in connected parts of the watershed). 

• Only wild, not stocked fish should be considered.  

 

Select all that are true: 

o Chinook are present in AA  
o Chinook in connected parts of same watershed within 8 km 
o Chinook in other connected parts of the same watershed 
o Chum are present in AA 
o Chum are in connected parts of same watershed within 8 km 
o Chum are in other connected parts of the same watershed 
o Coho/Silver are present in AA  
o Coho/Silver are in connected parts of same watershed within 8 km 
o Coho/Silver are in other connected parts of the same watershed.  
o None of the above, but other fish species are likely present in AA.  Or a stream 

connects the AA to other waters and is not known to be fishless.  
o Is known or likely to be fishless (e.g., too small, dry, and/or not accessible even 

temporarily, and not stocked).  
3.1.21 OF 21: ECOLOGICAL DESIGNATION 

Relevant Layers: 

o BC Parks, Ecological Reserves, and Protected Areas  
o Conservation Lands 
o Critical Habitat for Federally-Listed Species at Risk – Posted 
o Designated Lands 

https://catalogue.data.gov.bc.ca/dataset/3b723ef2-abd4-4722-abea-9a51258eae15
https://catalogue.data.gov.bc.ca/dataset/1130248f-f1a3-4956-8b2e-38d29d3e4af7
https://catalogue.data.gov.bc.ca/dataset/68327529-c0d5-4fcb-b84e-f8d98a7f8612
https://catalogue.data.gov.bc.ca/dataset/076b8c98-a3f1-429b-9dae-03faed0c6aef
https://github.com/bcgov/designatedlands/releases/download/v0.1.0/designatedlands.gpkg.zip
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o Species and Ecosystems at Risk - Publicly Available Occurrences - CDC  
o Ungulate Winter Range – Approved 
o TANTALIS – Conservancy Areas  
o TANTALIS – Wildlife Management Areas 

 

 

“Is the AA within or abuts a public or private area designated by government (public 

or First Nations), Nature Conservancy, or a conservation land trust for its heightened 

ecological importance?”  

 

NOTES: 

• Ecological designations may include areas with legal protection, management 

restrictions, or recognized ecological value.  

• Designations vary by jurisdiction; confirm data sources are current before 

analysis. 

 

Select one of the following:  

o Yes 

o No 

 

1. Add the relevant layers. 

2. Consider “Buffer_100m”. 
3. Use Intersect to compare “Buffer_100m” with the designated lands layer 

(see 9) and save it as “AA_DesignatedOverlap” 
4. Review the designation: 

i. Open the Attribute Table of “AA_DesignatedOverlap’’. 
ii. Locate the field indicating designation type (e.g., park, ecological 

reserve). 
iii. Confirm whether the wetland lies within or abuts a designated 

ecological area. 
3.1.22 OF 22: PROTECTION FROM INTENSIVE USES 

Relevant Layers: 

o Designated Lands 

o Conservation Lands 

o NGO Conservation Areas – Fee Simple 

o BC Parks, Ecological Reserves, and Protected Areas 

o Species and Ecosystems at Risk - Publicly Available Occurrences - CDC 

o TANTALIS – Wildlife Management Areas 

o TANTALIS – Conservancy Areas 

 

https://catalogue.data.gov.bc.ca/dataset/0e035e55-f257-458f-9a96-80c01c69d389
https://catalogue.data.gov.bc.ca/dataset/712bd887-7763-4ed3-be46-cdaca5640cc1
https://catalogue.data.gov.bc.ca/dataset/550b3133-2004-468f-ba1f-b95d0e281e78
https://catalogue.data.gov.bc.ca/dataset/f3ece977-aa7f-4cb2-b7d0-de64155f6c83https:/bcwildlife-my.sharepoint.com/personal/wew_bcwf_bc_ca/Documents/Wetlands%20Workforce/GIS/WESP/2025/2025%20Full%20GIS%20Analysis%20Guide/GIS%20Manual%202025%20V3%20(09.04).dotm
https://github.com/bcgov/designatedlands/releases/download/v0.1.0/designatedlands.gpkg.zip
https://catalogue.data.gov.bc.ca/dataset/68327529-c0d5-4fcb-b84e-f8d98a7f8612
https://catalogue.data.gov.bc.ca/dataset/a306e21b-58d6-4b71-bac7-f3b1c8a4c779
https://catalogue.data.gov.bc.ca/dataset/1130248f-f1a3-4956-8b2e-38d29d3e4af7
https://catalogue.data.gov.bc.ca/dataset/species-and-ecosystems-at-risk-publicly-available-occurrences-cdc
https://catalogue.data.gov.bc.ca/dataset/f3ece977-aa7f-4cb2-b7d0-de64155f6c83
https://catalogue.data.gov.bc.ca/dataset/550b3133-2004-468f-ba1f-b95d0e281e78
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“Are new timber harvest, roads, mineral extraction, and intensive summer 

recreation (e.g., off-road vehicles) permanently prohibited from the AA?” 

NOTE: Consider any lands that contribute to conservation, such as those with legal 

protection, management restrictions, or excluded activities (e.g., PPA, other 

protected areas). If such designations occur in or directly adjacent to the wetland, 

record them here. 

Select one of the following:  

o Yes 

o No 

3.1.23 OF 23: BGC PROTECTION PERCENTAGE 

The following iMapBC layer is required: 

o Forest Grasslands and Wetlands > Percent BGC Subzone Variant Protected  

 

“Consider the percentage of the wetland's biogeoclimatic subzone variant that is 

Protected: Forest Grasslands and Wetlands > Percent BGC Subzone Variant 

Protected. That percentage is:” 

 

NOTES: 

• Assign the AA to the BGC subzone variant covering the largest portion of the 

wetland. 

• The dataset reports the percentage of the entire BGC subzone variant that is 

provincially protected. 

• This value reflects protection at the provincial scale, not local conditions 

around your AA. 

 

Select one of the following:  

o 0-1% 

o 1.1-4% 

o 4.1-8% 

o 8.1-12% 

o 12.1-20% 

o > 20.1% 

1. Use Select Layer by Location to select BGC polygons that intersect the AA: 

i. Open the Attribute Table of selected features.  
ii. If multiple subzones overlap, determine which subzone covers the 

largest portion of the AA. 
2. Use Calculate Geometry if needed to measure overlap areas. 
3. Determine the protection percentage: 
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i. In the Attribute Table of the dominant BGC polygon, locate the field 

reporting the percent protected value, record the value, and select 

the appropriate category.  

3.1.24 OF 24: SPECIES OF CONSERVATION CONCERN 

Relevant Layers: 

o Species and Ecosystems at Risk - Publicly Available Occurrences - CDC 

o Wildlife Species Inventory – Incidental Observations – Publicly Available  

o Wildlife Species Inventory – Survey Observations – Publicly Available  

o Wildlife Species Inventory - Telemetry Points – Publicly Available 

o Wildlife Habitat Features – Incidental Observations – Publicly Available  

o Wildlife Habitat Features – Survey Observations – Publicly Available  

 

“Are there species of conservation concern (in the list below) that have been 

observed within a 500m buffer of the AA?” 

 

NOTES: 

To identify species of concern near your wetland: 

• Consult Experts: Regional biologists, First Nations knowledge holders, and 

agency staff. 

• Check Public Databases: 

o Use the BC Species and Ecosystems Explorer to identify Red/Blue-listed 

and SARA species. 

o BC Conservation Data Centre (CDC) 

o eBird.org (bird records) 

o iNaturalist.org (citizen-science observations) 

• Request Restricted Data (if your project is eligible): Submit wetland 

polygon(s) with a 500m buffer specified to the BC Conservation Data Centre 

to cdcdata@gov.bc.ca for masked/proprietary CDC records. 

• Consult the BC Species & Ecosystems Explorer for the current conservation 

status of each species that has occurrences within or nearby your wetland. 

Red, Blue, and SARA listed species should be considered as of conservation 

concern for this question.  

 

Select all the species of conservation concern that have been observed within a 

500m buffer of the AA : 

o Any plant species or community of conservation concern. 

o Any amphibian listed as being of conservation concern  

o Either of these waterbird species of conservation concern: American Bittern, 

Eared Grebe. 

https://catalogue.data.gov.bc.ca/dataset/species-and-ecosystems-at-risk-publicly-available-occurrences-cdc
https://catalogue.data.gov.bc.ca/dataset/7d5a14c4-3b6e-4c15-980b-68ee68796dbe
https://catalogue.data.gov.bc.ca/dataset/8f45a611-ce07-4e9f-a4b5-27e123972816
https://catalogue.data.gov.bc.ca/dataset/6d48657f-ab33-43c5-ad40-09bd56140845
https://catalogue.data.gov.bc.ca/dataset/wildlife-habitat-features-incidental-observations-publicly-available
https://catalogue.data.gov.bc.ca/dataset/wildlife-habitat-features-survey-observations-publicly-available
https://a100.gov.bc.ca/pub/eswp/
https://maps.gov.bc.ca/ess/hm/cdc/
https://ebird.org/home
https://www.inaturalist.org/
mailto:cdcdata@gov.bc.ca
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o Raptor or wetland songbird species of conservation concern:  Broad-winged 

Hawk, Swainson's Hawk, Northern Goshawk, Peregrine Falcon, Prairie Falcon, 

Long-billed Curlew, Western Screech-owl, Short-eared Owl, Black Swift, Olive-

sided Flycatcher, Barn Swallow, Cape May Warbler, and/or Rusty Blackbird. 

o Caribou 

 

 

1. Use the Explore or Identify tool to obtain latitude/longitude coordinates. 

2. Copy these coordinates for use in species databases. 

3. Review species records in available project-specific wildlife observation, 

eBird, iNaturalist, and any other available and relevant sources such as 

municipality datasets etc. 

4. Confirm species presence, conservation status, and habitat context based on 

available data. 

 

3.1.25 OF 25: LOCAL MOISTURE DEFICIT 

“In the next column, enter the CMD value (Annual) for the raster cell containing this 

wetland.” 

Using the online ClimateBC. Map Viewer find the approximate location of your 

wetland on the map. Select “Normal_1991-2020” in the “Historical” drop-down 

menu. 

3.1.26 OF 26: DEGREE DAYS INDEX 

“Enter the DD>5 value (Annual) for the raster cell containing this wetland.” 

Using the online ClimateBC. Map Viewer find the approximate location of your 

wetland on the map. Select “Normal_1991-2020” in the “Historical” drop-down 

menu. 

3.1.27 OF 27: LOCAL SOLAR INPUT 

“Enter the sum of RAD_sp and RAD_sm values (Seasonal) for the raster cell 
containing this wetland.” 

3.1.28 OF 28: SITE INDEX (SOIL NUTRIENTS) 

Relevant Layer: 

o VRI – 2024 – Forest Vegetation Composite Polygons  

“Enter the Site Index for the raster cell containing this wetland.  If VRI contains no 

data for this attribute at AA's location, leave blank. ” 

NOTES: Use the mean SI if working with a wetland that spans multiple cells. If the 

site index is unavailable or the value is "NaN", leave this question blank. 

Select one of the following: 

o <6.3% 

o 6.4 - 9.5% 

o 9.6 - 13.3% 

o 13.4 - 18.5% 

https://climatebc.ca/
https://climatebc.ca/
https://catalogue.data.gov.bc.ca/dataset/6ba30649-14cd-44ad-a11f-794feed39f40
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o >18.6% 

3.1.29 OF 29: TOPOGRAPHIC POSITION 

Relevant Layer: 

o VRI – 2024 – Forest Vegetation Composite Polygons  

 

“Enterthe Site_Position_Meso code (C, D, F, L, M, T, or U) for the raster cell 

containing this wetland.  If VRI contains no data for this attribute at the AA's 

location, leave the next cell blank.” 

NOTES: Use the provincial landform data to assign the appropriate slope position for 

the Assessment Area (AA). Landform codes include: 

• D = Depression (Valley, Local Valley in Plain) 

• F = Flat (Plains) 

• L = Lower slope 

• M = Middle slope (Gentle Slopes, Steep Slopes) 

• U = Upper slope (Hilltop in Valley, Headwaters) 

• T = Toe slope 

• C = Crest (Ridges and Peaks, Local Ridge in Plain) 

If no T (Toe slope) or L (Lower slope) code is present for the AA, use the most 

applicable available code based on inspection of terrain. 

3.1.30 OF 30: ROAD DENSITY WITHIN AA’S BUFFER 

Relevant Layer: 

o Digital Road Atlas (DRA) – Master Partially – Attributed Roads 

o BC Cumulative Effects Framework – Integrated Roads – 2025 

“Considering a buffer of 100 m from the AA's edge, identify visible roads and 

mapped roads in the Digital Road Atlas.  The length (km) of all roads within that 

buffer, divided by the buffer's area, is:” 

 

NOTES:  

• Include All road types (paved, unpaved, resource) within the buffer. Exclude 

the wetland area itself from calculations to avoid skewed density values. 

• If the road layer is in meters, convert units to kilometers before calculating 

density. 

 

Select one of the following:  

o < 0.12 km/km2  

o 0.13-0.30 km/km2  

o > 0.31 km/km2  

 

1. Consider the “Buffer_100m_NoWetland“  layer 
2. Select intersecting roads: 

i. Add the Integrated Roads layer. 

https://catalogue.data.gov.bc.ca/dataset/6ba30649-14cd-44ad-a11f-794feed39f40
https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
https://catalogue.data.gov.bc.ca/dataset/a489bc6a-f676-4503-8cd7-dcf0bdf2ae99
https://catalogue.data.gov.bc.ca/dataset/a489bc6a-f676-4503-8cd7-dcf0bdf2ae99
https://catalogue.data.gov.bc.ca/dataset/a489bc6a-f676-4503-8cd7-dcf0bdf2ae99


W E S P - B C  D E S K TO P  A S S E S S M E N T  3 2   |   B . C .  W I L D L I F E  F E D E R AT I O N   

32 

ii. Use Select Layer by Location with “Buffer_100m_NoWetland” (Spatial 
Relationship = Intersect). 

3. Export and calculate road length: 
i. Export the selected roads as “AllRoads_100m”. 

ii. In the Attribute Table, ensure the length field is in kilometers (see 
10). 

iii. Sum the total road length (see 0). 
4. Open the Attribute Table of “Buffer_100m_NoWetland”  

i. Confirm area in km2. 
5. Calculate road density using the formula below: 

𝑅𝑜𝑎𝑑 𝐷𝑒𝑛𝑠𝑖𝑡𝑦 =  
𝑇𝑜𝑡𝑎𝑙 𝑅𝑜𝑎𝑑 𝐿𝑒𝑛𝑔𝑡ℎ (𝐾𝑚)

𝐵𝑢𝑓𝑓𝑒𝑟 𝐴𝑟𝑒𝑎 (𝐾𝑚2)
 

3.1.31 OF 31: ROAD DENSITY WITHIN 2 KM OF THE AA 

Relevant Layer: 

o Digital Road Atlas (DRA) – Master Partially – Attributed Roads 

o BC Cumulative Effects Framework – Human Disturbance – 2023  
 

“Consider the 2 km buffer from the AA. The length (km) of all roads within that 

buffer, divided by the buffer's area, is:” 

Select one of the following: 

o < 0.12 km/km2  

o 0.13-0.30 km/km2 

o  > 0.31 km/km2  

 

1. Consider the “2km_buffer_excluding_AA” 
2. Follow the same remaining steps as OF 30 to calculate total road length, 

buffer area, and road density.  
3.1.32 OF 32: INTACTNESS OF LANDSCAPE WITHIN 2 KM 

Relevant Layer:  
o BC Cumulative Effects Framework – Human Disturbance – 2023 

“Within that 2-km buffer, the percentage that is Natural/Semi-Natural is:” 

Select one of the following: 

o <5% 
o 5.1-30% 
o 30.1-60% 
o 60.1-90% 
o >90.1% 

 
1. Consider the “2km_buffer_excluding_AA”. 

2. Extract disturbance features within the buffer by using Clip or Select Layer by 

Location and save as “HumanDisturbance_2km” 

3. Reclassify land cover into two categories: 

https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
https://catalogue.data.gov.bc.ca/dataset/7d61ff12-b85f-4aeb-ac8b-7b10e84b046c
https://catalogue.data.gov.bc.ca/dataset/7d61ff12-b85f-4aeb-ac8b-7b10e84b046c
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i. Intact (Natural/Semi-Natural): forest, wetland, grassland, etc. 

ii. Not Intact (Disturbed): urban, agriculture, clearcuts, etc. 

4. Calculate intact percentage following step 4 of OF 30. 

3.1.33 OF 33: MATURE & OLD GROWTH FOREST WITHIN 2 KM 

Relevant Layers:  

o Old Growth Technical Advisory Panel (TAP) – Old Forests 

 

“Within that 2-km buffer, the percentage of area mapped as Old Growth or 

Mature is:” 

NOTE: 

• The percentage is relative to total forested area within the 2 km buffer, not 

total land area. 

 

Select one of the following:  

o <5% 

o 5.1-30% 

o 30.1-60% 

o 60.1-90% 

o >90.1% 

1. Consider “Buffer-2km” layer. 
2. Select for Mature and Old Growth classes: 

i. Open the Attribute Table of the forest layer. 
ii. Open Select by Attributes to select features where the class = Mature 

OR class = Old. 

3. Extract forest features within buffer by Clipping the layer to 

“2km_buffer_excluding_AA” (see 12). 

i. Save as “Forests_within2km”. 

4. Clip the selected Mature + Old Growth subset the same way. 

i. Save as “Mature_OldGrowth_within2km”. 

5. Use Calculate Geometry to find total hectares for “Forests_within2km”. 

i. Repeat for “Mature_OldGrowth_within2km”. 

6. Determine the percentage using the formula below: 

 

𝑀𝑎𝑡𝑢𝑟𝑒 + 𝑂𝑙𝑑 𝐺𝑟𝑜𝑤𝑡ℎ % =  
𝑀𝑎𝑡𝑢𝑟𝑒 + 𝑂𝑙𝑑 𝐺𝑟𝑜𝑤𝑡ℎ 𝐹𝑜𝑟𝑒𝑠𝑡 𝐴𝑟𝑒𝑎

𝑇𝑜𝑡𝑎𝑙 𝐹𝑜𝑟𝑒𝑠𝑡 𝐴𝑟𝑒𝑎
 𝑋 100 

3.1.34 OF 34: LAND COVER TYPE UNIQUENESS 

Relevant Layers:  

o BC Land Cover (if available) 

o VRI attribute bclcs_level_5 

o Sentinel Land Cover   

https://catalogue.data.gov.bc.ca/dataset/6f08c9d8-d6c0-4f08-ac64-54585c92ccb0
https://ic.imagery1.arcgis.com/arcgis/rest/services/Sentinel2_10m_LandCover/ImageServer
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“Do any of the land cover types that are present in the AA comprise <1% of the land 

cover in the surrounding 1km or 5km buffers?” 

NOTE: Using best available land cover classification and aerial image interpretation 

to assess landscape diversity within 1 km and 5 km buffers around the wetland. 

Overlay the AA layer with each buffer and identify ‘unique’ land cover types present 

in each to determine if some of the land cover types within the wetland are rare 

compared to the surrounding areas. 

Landcover types should consider the following categories:  

· Barren Land 

· Coniferous Forest 

· Cropland 

· Deciduous Forest 

· Estuary 

· Grassland 

· Mixed Forest 

· Shrub Land 

· Snow and Ice 

· Urban and Built-up 

· Fresh Water 

· Marine Water 

· Wetland 

· Riparian Layers 

o Includes Coniferous Forest, Deciduous Forest, Mixed Forest, Grassland and 

Shrubland that overlaps with the Riparian Zone. 

· Intertidal and Subtidal 

· Herbaceous shrub 

 

Select all that apply: 

o Yes, at least one landcover type within the AA comprises <1% of the area within 

the 1 km buffer of the AA (and outside of the AA)  

o Yes, at least one landcover type within the AA comprises <1% of the area within 

5 km of the AA (and outside of the AA)  

o Neither of the above 

 

1. Determine the land cover types that are within the AA. (eg. Deciduous, 

coniferous, barren, open water etc.) 

2. Consider “Buffer_1km” and “Buffer_5km” and if any of the land cover types 

that occur within the AA are rare (<1% coverage) within the buffers. 
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i.  If you can tell that none of the land cover types within the AA are rare 

in the buffers, then you can select c) and not continue any further. 

3. To determine the percentage of the buffer covered by any rare land cover 

types, use Intersect with the best available landcover data and each buffer 

(see 9).  

i. Save the land cover layers as “Landcover_1km”, “Landcover_5km” 

4. Calculate land cover proportions using Calculate Geometry (see 10): 

i. Divide each type’s area by the total buffer area. 

ii. Identify any types where coverage is <1%. 

NOTE: In cases where available land cover mapping is inaccurate, defer to 

observed land cover types based on the most recent available imagery. 

3.1.35 OF 35: MAXIMUM DOMINANCE OF A LAND COVER TYPE 

Relevant Layer:  

o BC Land Cover (if available) 

o VRI attribute bclcs_level_5 

o Sentinel Land Cover   

 

“Identify the most extensive land cover type within the AA and calculate all the AA's 

vegetation that it comprises.” 

1. Select the AA and Clip the land cover (see 12) and save as “AA_Landcover”. 

2. Calculate areas by class using Calculate Geometry (see 10) and save as 

“Area_ha”. 

3. Summarize areas (see 0). 

4. Identify the dominant land cover type with the largest total area within the AA. 

i. Divide the area of the dominant land cover type by the total AA land 

cover area. 

5. Calculate proportions and enter the result as a decimal with a maximum value 

of 1. 

NOTE: If there's only one type of land cover in the AA, such as coniferous, the 

answer would be 1. If the wetland is made up of 60% grassland and 40% mixed 

forest, then the answer would be 0.6.   

3.1.36 OF 36: NUMBER OF LAND COVER TYPES IN THE AA AND 100 M BUFFER 

Relevant Layer:  

o BC Land Cover (if available) 

o VRI attribute bclcs_level_5 

o Sentinel Land Cover   

“The number of different land cover types mapped within the AA, plus all land 

cover types within 100 m of its edge is:” 

https://ic.imagery1.arcgis.com/arcgis/rest/services/Sentinel2_10m_LandCover/ImageServer
https://ic.imagery1.arcgis.com/arcgis/rest/services/Sentinel2_10m_LandCover/ImageServer
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NOTE: Use the land cover classification to identify distinct types present within the 

AA and its 100 m buffer. Each unique class counts once, regardless of area. 

NOTE: In cases where available land cover mapping is inaccurate, defer to observed 

land cover types based on the most recent available imagery. 

 

Select one of the following:  

o 1 

o 2 

o 3 or 4 

o >4 

 

1. Consider the “Buffer_100m_including_AA” layer.  

2. Clip the land cover layer to the “Buffer_100m_including_AA” layer (see 12) and 

save as “Landcover_AA_100m”. 

3. Identify unique classes by using the Attribute Table and reviewing the 

Classification field. 

i. If unclear, run Summary Statistics (see 0).  

4. Count the number of unique land cover types present and select the 

appropriate category. 

3.1.37 OF 37: NUMBER OF LAND COVER TYPES WITHIN 2 KM 

Relevant Layer: 

o BC Land Cover (if available) 

o VRI attribute bclcs_level_5 

o Sentinel Land Cover   

o Aerial imagery 

“The sum of the number of different land cover types mapped within the AA plus 

all types within the 2 km buffer is:” 

NOTE: Use the land cover classification to identify distinct types present within the 

AA and its 2 km buffer. Each unique class counts once, regardless of area. 

NOTE: In cases where available land cover mapping is inaccurate, defer to observed 

land cover types based on the most recent available imagery. 

Select one of the following:  

o <4 

o 4 or 5 

o 6 or 7 

o 8 to 11 

o >11 

 

1. Consider the “Buffer_2km” layer. 

https://ic.imagery1.arcgis.com/arcgis/rest/services/Sentinel2_10m_LandCover/ImageServer
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2. Clip the land cover layer to the combined AA + 2 km buffer extent (see step 3 

OF 19 and section 0). 

3. Follow the same steps used in OF 36 to identify unique land cover types and 

determine the final count. 

3.1.38 OF 38: DECIDUOUS LAND COVER WITHIN THE AA AND 100 M BUFFER 

Relevant Layer: 

o VRI - 2024 - Forest Vegetation Composite Polygons 

 

“The percentage of the deciduous land cover type within the AA plus 100 m from 

its edge, as compiled from the land cover layer, is:” 

NOTE: In cases where available land cover mapping is inaccurate, defer to observed 

land cover types based on the most recent available imagery. 

Select one of the following:  

o <6% 

o 6-20% 

o 21-39% 

o 40-66% 

o >66% 

 

1. Consider the “Landcover_AA_100m” layer. 

2. Open the Attribute Table and consider the attribute bclcs_level_4, which 

indicates the type of vegetation. 

i. Under bclcs_level_4 values of “TB” (tree-broadleaf) should 

be considered for this question 

3. Calculate areas using the Calculate Geometry (see 10) to find the area of 

deciduous polygons (ha). 

4. Use the formula below: 

𝐷𝑒𝑐𝑖𝑑𝑢𝑜𝑢𝑠 % =  
𝑇𝑜𝑡𝑎𝑙 𝐷𝑒𝑐𝑖𝑑𝑢𝑜𝑢𝑠 𝐴𝑟𝑒𝑎

𝑇𝑜𝑡𝑎𝑙 𝐴𝐴 + 100𝑚 𝐵𝑢𝑓𝑓𝑒𝑟 𝐴𝑟𝑒𝑎
 𝑋 100 

3.1.39 OF 39: CLOSED CONIFEROUS LAND COVER WITHIN THE AA AND 100 M BUFFER 

Relevant Layer:  

o VRI - 2024 - Forest Vegetation Composite Polygons 

 

“The proportion of the coniferous land cover type within the AA plus 100 m from 

its edge, as compiled from the land cover layer, is:” 

NOTE: In cases where available land cover mapping is inaccurate, defer to observed 

land cover types based on the most recent available imagery. 

Select one of the following: 

o <20% 

o 20.1-47% 

o 48-69% 

https://catalogue.data.gov.bc.ca/dataset/6ba30649-14cd-44ad-a11f-794feed39f40
https://catalogue.data.gov.bc.ca/dataset/6ba30649-14cd-44ad-a11f-794feed39f40
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o 70-90% 

o >90.1% 

 

NOTE: For OF 39, follow the same process as OF 38, but filter for closed coniferous 

stands instead of deciduous types (bclcs_level_4 = “TC”).  

3.1.40 OF 40: NON-TREE VEGETATION WITHIN THE AA AND 100 M BUFFER 

Relevant Layer: 

o VRI - 2024 - Forest Vegetation Composite Polygons 

 

“The percentage of the land cover that is non-tree, within the AA plus 100 m from 

its edge, as compiled from the land cover layer, is:” 

NOTE: In cases where available land cover mapping is inaccurate, defer to observed 

land cover types based on the most recent available imagery. 

Select one of the following:  

o <9% 

o 9.1-24% 

o 25-44% 

o 45-74% 

o >74.1% 

 

NOTE: For OF 40 follow the same process as OF 38, but filter non-tree vegetation 

instead of deciduous types.  

3.1.41 OF 41: DISTURBED AREA PERCENTAGE IN THE WAU 

Relevant Layer: 

o BC Cumulative Effects Framework – Human Disturbance – 2023 

 

“As a percentage of the WAU, the Disturbed area (GIS layer provided) comprises:” 

 

NOTE: This measure reflects disturbance proportion across the full WAU, not just 

within the AA. 

 

Select one of the following:  

o <10% 

o 10.1-20% 

o 20.1-30% 

o 30.1-40% 

o >40.1% 

 

1. Clip the layer to the WAU boundary (see step 3 of OF 19) and save as 

“Disturbed_WAU”. 

https://catalogue.data.gov.bc.ca/dataset/6ba30649-14cd-44ad-a11f-794feed39f40
https://catalogue.data.gov.bc.ca/dataset/7d61ff12-b85f-4aeb-ac8b-7b10e84b046c
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2. Open the Attribute Table of “Disturbed-WAU” to calculate the total lengths 

(km). 

3. Disturbance is typically coded as 1 = Not disturbed and 2 = Disturbed. 

i. Filter for “Disturbed (2)” values only. 

4. Use Calculate Geometry to measure the disturbed area in hectares and sum 

these values for the total disturbed area (see 10, 0). 

5. Use the formula below: 

𝐷𝑖𝑠𝑡𝑢𝑟𝑏𝑒𝑑 % (𝑊𝐴𝑈) =  
𝑇𝑜𝑡𝑎𝑙 𝐷𝑖𝑠𝑡𝑢𝑟𝑏𝑒𝑑 𝐴𝑟𝑒𝑎

𝑇𝑜𝑡𝑎𝑙 𝑊𝐴𝑈 𝐴𝑟𝑒𝑎
 𝑋 100 

3.1.42 OF 42: ROAD DENSITY IN THE WAU 

Relevant Layer: 

o BC Cumulative Effects Framework – Integrated Roads – 2025 

o Digital Road Atlas (DRA) – Master Partially – Attributed Roads 

“Intersect the WAU with the Digital Road Atlas.  The length (km) of all roads within 

that WAU, divided by the WAU's area, is:” 

NOTE: Include all road types present in the Integrated Roads layer (paved, unpaved, 

and resource roads). 

 

Select one of the following:  

o <0.4 km/km2  

o 0.5-1.2 km/km2  

o > 1.3 km/km2  

 

1. Clip the layer to the WAU boundary (see Step 3 of OF 19) and save as 

“Roads_WAU”. 

2. Open the Attribute Table to calculate the total road length (see step 3 of OF 

30). 

i. Sum the total length (see 0). 

3. Use the “Road density” formula and choose the appropriate category. 

i. Confirm the WAU area in km2 (Appendix A:10) 

3.1.43 OF 43: WETLAND DENSITY IN THE WAU 

Relevant Layer:  

o Freshwater Atlas – Wetlands 

o Any additional local wetland mapping (if available) 

 

“The summed area of all wetlands in the wetland's WAU, divided by the WAU's 

area, is:” 

Select one of the following:  

o <0.03 

o 0.03-0.04 

https://catalogue.data.gov.bc.ca/dataset/a489bc6a-f676-4503-8cd7-dcf0bdf2ae99
https://catalogue.data.gov.bc.ca/dataset/bb060417-b6e6-4548-b837-f9060d94743e
https://catalogue.data.gov.bc.ca/dataset/93b413d8-1840-4770-9629-641d74bd1cc6
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o 0.05-0.07 

o 0.08-0.13 

o >0.13 

 

NOTE: Follow the same process as OF 42, but instead of summing road length, 

calculate the total wetland area within the WAU and divide by the WAU’s total area 

to determine the proportion. 

3.1.44 OF 44: ECOPROVINCE 

Relevant Layer: 
o Ecoprovinces - Ecoregion Ecosystem Classification of British Columbia 

 

“The AA's ecoprovince is:” 

Select from the following:  

o Boreal Plains (BP) 

o Central Interior (CI) 

o Coast & Mountains (CM) 

o Georgia Depression (GD) 

o Northern Boreal Mountains (NBM) 

o Southern Interior (SI) 

o Southern Interior Mountains (SIM) 

o Sub-Boreal Interior (SBI) 

o Taiga Plains (TP) 

 

 

1. Identify the AA’s exoprovince: 

i.  Use Select Layer by Location and intersect (see 9) 

2. Confirm ecoprovince classification: 

i.  Open the Attribute Table of the selected polygon. 

ii. Locate the Ecoprovince name/code field. 

3. Select the matching option from the list above. 

 

 

 

 

 

 

 

 

 

 

https://catalogue.data.gov.bc.ca/dataset/51832f47-efdf-4956-837a-45fc2c9032dd
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APPENDIX-A. COMMON GIS TOOLS 

1  CREATING A BUFFER 
Buffers are used to define an area within a specified distance around features. 

 
1. Open the Buffer Tool (Go to Analysis > Tools > Buffer). 

2. Set Input Features:  

i. Choose the feature layer you want to buffer (e.g., CA_Polygon, 

AA_of_Interest) 

3. Specify buffer Distance: 

ii. Enter the distance (e.g., 2000 Meters). 

iii. Choose the correct unit (meters, kilometers, etc.). 

4. Choose Dissolve Option (If needed): 

i. ALL: merges overlapping buffers into one area. 

ii. NONE: keeps each feature’s buffer separate. 

5. Save as “Bufefr_2km”. 

6. Click Run. 

 
 

TIP: Adjust layer transparency (see 2) for instruction on how to overlap the buffer with 

other layers. 
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2  OPTIMIZING LAYER TRANSPARENCY 
Transparency allows you to see multiple layers at once by making one layer partially 
see-through. This is useful when comparing overlapping datasets. 
 

4. Select the layer of interest in the Contents Pane. 

5. Open the Appearance tab (Go to the Feature Layer > Appearance on the 

ribbon). 

6. Adjust Transparency: 

i. Use the Transparency slider to set the desired level (i.e., 70%) 

3. Arrange order of layers in the Contents Pane to ensure your transparent layer 

is above the reference layers. 
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3  ADDING DATASETS TO MAP  
1. Go to the Map tab > click Add Data > choose Data from ArcGIS Online. 

2. In the search bar, enter the dataset name (i.e., “Freshwater Atlas Lakes”) 

3. Look for authoritative sources (e.g., from @gov.bc.ca). 

4. Click the desired dataset > click Add. 

5. The layer is added to your map and appears in the Contents pane. 

 

4 ACCESSING SPATIAL DATA USING WESPR PACKAGE 
The WESPR GitHub includes instructions on how to prepare spatial data and use a 

package that obtains the majority of the datasets from the BC data package. This 

package shows if there are no layers within your relevant search area, and eases the 

burden of viewing each dataset separately.  

5 EXPORTING DATA FROM IMAPBC 
1. Go to iMapBC. 

2. Use Add Provincial Layers in the Data Sources tab to find and check off the 

layers you need. 

3. Click the Export tab. 

4. Select Provincial Layer Download. 

5. In the download service panel, select the layers you want (toggle on/off), 

choose area of interest (extent), select output format (e.g. Shapefile preferred) 

and coordinate system. 

6. Enter your email if required, agree to terms, then Submit Order. 

7. Wait for a link with the download; unzip/import into ArcGIS Pro. 

 

6 USING THE BC DATA CATALOGUE 
1. Go to BC Data Catalogue  

2. Search for the dataset name or topic (i.e., “Freshwater Atlas Wetlands”). 

3. Use filters like Format = Shapefile or geodata to narrow results. 

4. Download the data and unzip if needed. 

5. In ArcGIS Pro, go to Map > Add Data > browse to the extracted shapefile or 

layer package. 

 

7 ADDING BASEMAPS 
Basemaps provide background context for your data. ArcGIS Pro includes built-in 

basemaps such as Topographic, Imagery, Streets, and more. 

1. Open the Basemap gallery and click Basemap. 

https://catalogue.data.gov.bc.ca/dataset/cb1e3aba-d3fe-4de1-a2d4-b8b6650fb1f6
https://bcwf-wetlands.github.io/wespr/articles/prepare_spatial_data.html
https://maps.gov.bc.ca/ess/hm/imap4m/
https://catalogue.data.gov.bc.ca/datasets
https://catalogue.data.gov.bc.ca/dataset/93b413d8-1840-4770-9629-641d74bd1cc6
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2. From the gallery, choose the desired basemap (e.g., Topographic, Imagery, 

Streets). 

3. To manage visibility, you can toggle the basemap on/off in the Contents pane.  

8  MEASURE DISTANCES 
The Measure Tool allows you to calculate distances directly on the map. This isuseful for 

estimating travel paths or validating buffer distances. 

1. Go to Map and click the  . 

2. Choose measurement type by selection the Distance option. 

3. If needed, set the desired units (e.g., meters, kilometers) from the drop-down 

list. 

4. Measure distance: 

i. Click once on the map to set the starting point. 

ii. Click again to set the end point. 

iii. The distance is displayed in the Measure window. 

5. To finish the measurement, double-click to the end of the measurement. 

9  INTERSECT FEATURES 
The Intersect Tool combines two or more layers and keeps only the areas where they 

overlap. This is useful when you need to find features that share the same space (e.g., 

wetlands within a buffer, roads crossing a watershed). 

1. Open the Intersect Tool (Go to Analysis > Tools > Intersect). 

2. To set the Input Features, select two or more layers you want to intersect (e.g., 

Wetlands_2km and Buffer_2km). 

3. In the tool options, set the desired output type (e.g., Point, Line, Polygon). 

4. Save the results with a clear name (e.g., Clipped_Wetlands_ 2km). 

5. Click Run. 

 

10  CALCULATE GEOMETRY  
The Calculate Geometry function allows you to populate a field with geometric properties 

of features, such as area, length, or coordinates. This is useful for reporting results (e.g., 

hectares of wetlands, length of streams). 

1. Right-click the layer of interest in the Contents Pane and select Attribute Table.  

2. If needed, add a new field by selecting Add Field. 

i. Name the field clearly (e.g., Area_ha, Length_km). 

ii. Set Data Type = Double to store decimal values. 

iii. Click save to add the field data. 
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3. Open the Calculate Geometry by clicking the new field heading. 

4. Choose the desired geometry property (e.g., Area, Length, X/Y Coordinates). 

5. Click Run. 
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11  ERASE FEATURES 
The Erase tool removes portions of one layer that overlap another layer. The output 

contains only the parts of the input features that do not overlap the erase features. This 

is useful when you want to exclude areas (e.g., subtracting wetlands from a contributing 

area). 

1. Open the Erase Tool (Go to Analysis > Tools > Erase). 

2. To set Input Features, choose the layer that you want to clip (keep parts 

outside the erase area). 

3. Choose the layer that will be removed from the input (e.g., AA_polygon). 

4. Save the results with a clear name (e.g., CA_excluding_AA). 

5. Click Run. 
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12  CLIP FEATURES 
 

The Clip Tool trims features to the boundary of another layer. The output contains only the 

portions of the input features that fall inside the clip features. This is useful for restricting 

data to an area of interest (e.g., clipping streams to a watershed). 

 

1. Open the Clip Tool (Go to Analysis > Tools > Clip). 

2. To set Input Features, select the layer you want to trim. 

3. To set Clip Features, choose the boundary layer thar defines the area of 

interest (e.g., AA_boundary). 

4. Save the results with a clear name (e.g., Streams_within_watershed). 

5. Click Run.  
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13 SUMMARY STATISTICS 
The Summary Statistics tool calculates totals, averages, and other statistics for one or 

more fields in a dataset, grouped by an attribute (e.g., land cover type). 

1. Open the tool and search for Summary Statistics. 

2. Set inputs: 

i. Input Table = the dataset you want to summarize (e.g., “AA_Landcover”). 

ii. Output Table = choose a name and save location (e.g., 

“AA_Landcover_Summary”). 

3. Choose fields and statistics: 

i. Under Statistics Fields, select the numeric field you want to summarize 

(e.g., Area_ha). 

ii. Choose a statistic type (e.g., Sum, Mean, Minimum, Maximum). 

iii. You can add multiple fields or multiple statistics if needed. 

4. If you want results broken down by category (e.g., land cover type), add the 

relevant field under Case Field. 

i. If no Case Field is set, results will be calculated for the entire table. 

 


